Be A Better Auditor.
You Have The Knowledge.
We Have The Tools.
IDEA Version Nine Tutorial

A CaseWare IDEA Document
Contents

Preface ................................................................................................................. 7

Chapter 1
IDEA Overview ...................................................................................................... 9
  Desktop Projects ................................................................................................. 9
  IDEA Server Projects ......................................................................................... 10
  The Association Between Desktop and IDEA Server Projects ..................... 10

Chapter 2
IDEA Windows and Toolbars ............................................................................... 11
  Database Window ............................................................................................... 11
  Properties Window ............................................................................................. 12
  IDEAScript Window .......................................................................................... 13
  File Explorer Window ......................................................................................... 13
  Library Window ................................................................................................ 14
  Fly-Out Windows ............................................................................................... 15

Chapter 3
Getting Started .................................................................................................... 17
  Introduction ........................................................................................................ 17
  Accessing IDEA .................................................................................................. 17
  Selecting a Project ............................................................................................. 17
  Connecting to IDEA Server ............................................................................. 18
  Importing a Microsoft Access File .................................................................... 18
  Formatting the Data .......................................................................................... 19
  Viewing the Field Statistics .............................................................................. 21
  Selecting a Random Record Sample ................................................................. 22
  Extracting Records ............................................................................................ 24
  Importing a Text File ......................................................................................... 25
  Summarizing the Data ....................................................................................... 29
  Stratifying the Data ........................................................................................... 31
  Viewing the Results Graph .............................................................................. 33
  Creating a Pivot Table ......................................................................................... 34
  Joining Databases .............................................................................................. 36
  Reviewing the History ....................................................................................... 37
  Using Display All Records Containing ............................................................. 38
Preface

IDEA (originally an acronym for Interactive Data Extraction and Analysis) provides auditors, accountants, and systems and financial professionals with the ability to display, read, analyze, manipulate, sample, and extract data from data files from almost any source - mainframe to personal computers, including reports printed to a file. IDEA extends your reach by providing unique functions and features not found in generic software.

IDEA combines considerable analysis power with an extremely user-friendly Windows environment. This versatile tool is useful for any type of file interrogation and allows users to:

- Import data from a wide range of file types.
- Create custom views of data and reports.
- Perform analyses of data, including calculation of comprehensive statistics, gap detection, duplicate detection, summaries, and aging.
- Perform calculations.
- Select samples using several sampling techniques.
- Match or compare different files.
- Create pivot tables for multi-dimensional analysis.
- Automatically generate a complete history that documents the analysis.
- Record, create, and edit macros with IDEAScript (a customizable VBA-compatible scripting tool) and Visual Script.
- Conduct exception testing of unusual or inconsistent items using simple or complex criteria.

IDEA has built-in @Functions for arithmetic, text, time, and date criteria, including many financial @Functions. These @Functions perform operations such as date, arithmetic, financial and statistical calculations, and text searches.
Chapter 1

IDEA Overview

This tutorial covers the functionality of IDEA and IDEA Server.

Throughout the tutorial, the above products will be referred to solely as IDEA unless otherwise specified. In addition, the images used throughout this tutorial may not necessarily reflect what you see on your screen depending on the IDEA product you are using.

There is extensive online help available for all modules, including step-by-step walk-throughs of tasks. In order to view the online help, you require Internet Explorer 4.01; however, Internet Explorer 6.0 or higher is recommended. You may also visit the CaseWare IDEA website at www.CaseWare-IDEA.com for additional information such as tips and hints, frequently asked questions (FAQs), and technical information.

Your feedback is important to us. Send your documentation-related comments to IDEADocumentation@caseware.com.

Desktop Projects

It is recommended that the data files for each audit or investigation be stored in separate folders to simplify the management and housekeeping of databases and other files associated with the audit or investigation.

IDEA uses projects to organize audit files. A project is a sort of IDEA container used to hold a set of original files, which make up the data imported from a client, and any files subsequently generated through analysis. IDEA allows you to create two types of local Desktop projects: Managed and External.

<table>
<thead>
<tr>
<th>Managed</th>
<th>External</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within C:\Users\Your USERID\Documents\My IDEA Documents\IDEA Projects</td>
<td>Outside C:\Users\Your USERID\Documents\My IDEA Documents\IDEA Projects</td>
</tr>
<tr>
<td>Can be linked to IDEA Server projects</td>
<td>Can point to pre-IDEA Version Nine Working Folders</td>
</tr>
</tbody>
</table>

When you first launch IDEA, you will have access to two default Managed projects: Samples and Tutorial. The Samples and Tutorial projects contain all the files required to complete the exercises in
this guide, the Report Reader for Version Nine Tutorial, and the Advanced Statistical Methods for IDEA Version Nine Case Study, as well as the follow along with the examples in the Language Browser.

**IDEA Server Projects**

While an IDEA Server project is identical in function to a Desktop project, there are several key differences between the two:

- **Location:** The location of an IDEA Server project is determined by the IDEA Task Management Server.
- **Creation:** An IDEA Server project can only be created by an IDEA Server Team Leader.
- **Access:** A basic user simply has rights to access projects to which they have been assigned by an IDEA Server Team Leader.

**The Association Between Desktop and IDEA Server Projects**

When linking Desktop and IDEA Server projects, keep the following information in mind:

- **When** connecting to IDEA Server, the IDEA Server project that becomes active will become linked to the active Desktop project. From then on, every time you work in that Desktop project, IDEA will automatically connect to its associated IDEA Server project.
- **If** you change your Desktop project, the connection will change to the IDEA Server project associated with it, if a connection was previously made.
- **If** you have a Desktop project and its associated IDEA Server project open and you change the IDEA Server project through the Project Properties dialog box, the IDEA Server project you link to will become associated with the current Desktop project.
- **Associations** between Desktop projects and IDEA Server projects will always remain as defined unless you manually change the association through the Project Properties dialog box.
- **You** can have one IDEA Server project associated with several Desktop projects, however, you cannot have one Desktop project associated with several IDEA Server projects.
IDEA Windows and Toolbars

IDEA uses the following primary windows, which are described in this section: Database, Properties, File Explorer, Library, IDEAScript, and Fly-Out.

Database Window
The Database window allows you to view the fields contained within a database. Although multiple databases may be open at one time, each database is opened in a separate Database window and the name of the active database is displayed on the IDEA title bar.

Database window with Sales Transaction database open
Properties Window

Each database has several properties associated with it that are accessed from the Properties window. These properties are:

- **Data**: Used to view the data in the file in a spreadsheet-like format with field names as column headings and record numbers as row numbers.
- **History**: Used to view the history of all operations performed on the file. Each database has its own separate History.
- **Field Statistics**: Used to view the statistics for Numeric, Date, and Time fields in the active database.
- **Control Total**: Used to display the sum of a selected Numeric field for reconciliation purposes.
- **Criteria**: Used to isolate records that satisfy entered criteria.
- **Results**: Used to view the Results output for certain tasks.
- **Indices**: Used to switch between created index orders, delete index orders, and remove an index order from the active database.
- **Comments**: Used to add comments to the active database. It is also used by IDEA to display warning messages related to the active database.

![Properties window](image)
IDEAScript Window

IDEA includes a development tool known as IDEAScript for creating macros to extend the functionality of IDEA. IDEAScript can be recorded, written from scratch, or a combination of both. The IDEAScript code is generated or written in the IDEAScript window. This window has a toolbar providing access to a number of commonly used options and tools to assist with writing, editing, and debugging IDEAScript macros.

As of IDEA Version Eight, you can also create macros through a new feature called Visual Script. Visual Script is used to visually create, edit, and maintain macros in IDEA. In essence, Visual Script is the visual representation of IDEAScript. The benefit of Visual Script is that it allows you to automate tasks that you perform repeatedly without writing any code or programming. If required, you can then convert your Visual Script macros into IDEAScript macros. For more information on Visual Script, see the IDEA online Help.

File Explorer Window

The File Explorer window displays all of the IDEA databases in a project in a tree or a sorted view. If you have access to IDEA Server, the File Explorer window becomes a horizontal split screen between Desktop Project and IDEA Server Project.

The File Explorer window can be resized to show the full details of a database, including the database name, the number of records, the size, the date the database was last modified, and the date the database was created.

The File Explorer also has a toolbar from where you perform such actions as creating a sub-folder, changing the display from sorted to tree view, refreshing the list of databases, and renaming, flagging, or deleting databases.
Library Window  

In IDEA, a Library is a repository of files. Each Library in IDEA contains Library groups in which you can organize the files associated to the project.

When a project is created, IDEA creates Library sub-folders that let you organize all associated project files. The Library window in IDEA displays these sub-folders as system Library groups and lists the files contained in the groups. The groups in the Library are Custom Functions, Equations, Exports, Import Definitions, Macros, Other, Results, and Source Files.

For each file in the Library, you can view the file size and the date the file was last modified.

From the Library window, you can perform such actions as creating custom Library groups, deleting files, running macros, and copying files to another Library.
There are three separate libraries available in IDEA:

- **Corporate Library**: A repository of files on IDEA Server compiled by IDEA Server Team Leaders. The Corporate Library contains the standard system Library groups. Team Leaders can add files to these system Library groups or create new custom Library groups. Users that are connected to IDEA Server can copy files from the Corporate Library to their Current Project Library.

- **Local Library**: A repository of files on your local drive that you use to share files with all your Desktop projects. The Local Library is always available when you access IDEA. The Local Library folder is created when you install IDEA and can be found at C:\Users\YOUR USERID\Documents\My IDEA Documents.

- **Current Project Library**: A repository of files for the active Desktop project as well as the linked IDEA Server project, if applicable.

**Fly-Out Windows**

The following fly-out windows are available as tabs at the base of the application window: Running Tasks and Search Results.

The fly-out windows can be pinned down by clicking the push pin icon in the upper-right corner of the window.

- **Running Tasks**: The Running Tasks fly-out window provides you with the progress information for a particular task that is running.

- **Search Results**: IDEA displays the results of a search in the Search Results fly-out window. Within this window, new searches overwrite old ones. From the right-click menu in the Search Results window, you can re-run the search (as is or make refinements) or print the results. You may sort the results by double-clicking any of the columns within the Search Results window. A directional arrow appears in the field header to indicate the sort order (ascending or descending). IDEA Server allows multiple users to be searching the same database simultaneously without the risk of overwriting another user's search results.
Getting Started

Introduction

The exercises in this section are meant as an introduction for new users and a refresher for existing users. Each exercise has an objective to indicate what you will achieve in that area upon completion. The tutorial exercises should be completed sequentially as tests are often carried out on the results of previous exercises.

For more information on using IDEA:

- access the Help system in the software
- visit the IDEA Support section on the CaseWare IDEA Web site (www.CaseWare-IDEA.com)
- attend one of the many training courses

Accessing IDEA

From the Windows Start menu select, Programs > IDEA > IDEA.

By default, the Managed project is set to Samples. The databases in this Managed project are example databases on which you can test IDEA with.

Selecting a Project

Objective: To set a Managed project. One Managed project will be used to complete all exercises in this section.

1. On the Home tab, in the Projects group, click Select.
2. Under the Managed Projects tab, select Tutorial.
3. Click OK.

The project named Tutorial becomes the active project, closing the Samples project (the default Managed project). The File Explorer is now empty. You will also notice that on the Status bar on the bottom left corner of the application window it shows Managed Project: Tutorial.
Connecting to IDEA Server  
Objective: To connect to IDEA Server. As IDEA Server is a client-server application, the IDEA databases reside and the tasks run on the server. Hence, you must connect to the server to access the databases and analyze the data. See The Association Between IDEA Working Folders and IDEA Server Projects.

1. On the Home tab, in the IDEA Server group, click Select Server.
2. From the Select a server drop-down list, select the appropriate server. Alternatively, click Add to add a server.
3. Click OK.

Importing a Microsoft Access File  
Objective: To import a Microsoft Access file and generate field statistics for the newly imported database.

1. On the Home tab, in the Import group, click Desktop.
2. In the Import Assistant dialog box, select Microsoft Access from the list.
3. Click the Browse button next to the File name box to select the Microsoft Access database you want to import.
4. Select Customer.MDB.
5. Click Open.
6. Click Next.
7. From the Microsoft Access® box, in the Select tables window, select Database1.
   If you import a Microsoft Access file that contains more than one table, you may simultaneously import multiple tables by selecting the associated check boxes. However, any options you select will apply to all imported tables.
8. In the Character Field Options area, leave the Scan records for field length check box selected. All Character fields will be imported with a length of 255 characters unless changed. This is not likely to be the underlying Character field length.
9. Accept the default value in the Scan only box in order to scan 10,000 records to determine the maximum field length.
10 Accept the default output file name (Customer), and then click OK.

When the file is imported, the database name becomes filename-tablename. In this case, the file you imported becomes an IDEA database called Customer-Database1.

**Formatting the Data**

*Objective: To change the column formatting for selected fields and to sequence the records.*

1 Ensure that Customer-Database1 is the active database with the Data property selected in the Properties window.

2 Move the cursor to the column separator between the first two field names. Click the column separator and reduce the width of the CUST_NO field to fit the data.

3 Place the mouse pointer over the first field header. The tooltip displays the field type and the field length.

4 Sequence the CREDIT_LIM field in ascending order by double-clicking the column header. A directional arrow pointing upwards appears in the CREDIT_LIM column header to indicate the field has been indexed in ascending order. Also, note how the index is displayed in the Indices area of the Properties window.

5 Return to the original record sequence by clicking No index in the Indices area of the Properties window.
6 In the Database window, right-click over the **CUST_NO** column header to display a list of commonly used tasks and functions.

7 Select **Column Settings**....

8 For the **CUST_NO** field, make the text color blue, the background color light gray and change the font to bold.
9 For the **CREDIT_LIM** field, make the text color purple and the background color light gray. Accept the options to use the currency symbol and the thousands separator.

![Column Settings](image)

10 Click **OK** to exit the Column Settings dialog box. Note that the formatting changes have been applied to the database.

11 Re-order the fields by moving the **CREDIT_LIM** field after the **CUST_NO** field. Click the **CREDIT_LIM** column header to select it, and then click it again and hold down the mouse button to display the drag icon. Drag the column towards the **CUST_NO** field. Note the red line indicating the drag position. Drop the column to the right of the **CUST_NO** field.

   **Note:** Once you change a view, IDEA saves the settings with the database. These settings remain active until you change or reset them. Any child databases created from this database, inherit the settings.

12 On the **View** tab, in the **Views** group, click **Reset** to remove the format changes.

### Viewing the Field Statistics

**Objective:** To view the field statistics for the Numeric fields in the active database.

1 Ensure that **Customer-Database1** is the active database and the **Data** property is selected in the **Properties** window.

2 In the **Properties** window, click **Field Statistics**.

3 Click **Yes** to generate field statistics for all fields.
By default, the Field Statistics window displays the statistics for Numeric fields. In this case, field statistics appear for the CREDIT_LIM field, the only Numeric field in the database.

4 To view field statistics for the Date fields and Time fields in a database, click Date and Time in the Field Type area of the Field Statistics window. In the current database, there are no Date or Time fields. If the database contained more than one Date, Numeric, or Time field, multiple date, numeric, or time field statistics would appear together on the same screen for easy comparison of values.

5 Study the field statistics for the CREDIT_LIM field.

6 View the record with the maximum value by clicking the value in the Maximum Value field.

7 The Maximum Value of CREDIT_LIM dialog box appears, displaying the record from the database that constitutes the maximum value. You may save or print the record. Click Done.

8 In the Properties window, click Data to return to viewing the database.

Selecting a Random Record Sample

Objective: To select a random sample of records for testing.

1 On the Analysis tab, in the Sample group, click Random.

2 In the Number of records to select box, enter 10.

3 Accept the random number seed provided by IDEA.

   IDEA uses the random number seed to start the algorithm for calculating the random numbers. If a sample needs to be extended, then entering the same random number seed but with a larger sample size produces the same original selection plus the required additional records.

4 Accept the defaults in the Starting record number to select and the Ending record number to select boxes.

5 IDEA sets the defaults as the first and last records; in this case 1 and 341.

6 Leave the Allow duplicate records check box unselected.
In the **File name** box, enter **Sample of Customers**.

![Random Record Sampling dialog box](image)

Click **Fields**. The Fields dialog box appears. Note that by default, IDEA selects all fields from the database to extract to the Sample of Customers database.

Click **OK**.

In the Random Record Sampling dialog box, click **OK**.

View the resultant database and note the additional field (SAM_RECNO) that IDEA has added to the database as the right-most column. This contains the corresponding record numbers from the original database (Customer-Database1). Note that the database appears as a child database to its parent database (Customer-Database1) in the File Explorer window.

![Customer-Database1](image)

Close the **Sample of Customers** database by right-clicking the **Sample of Customers** tab and selecting **Close**.
Extracting Records  

Objective: To extract records of customers with high credit limits.

1. On the Analysis tab, in the Extract group, click Direct.

2. In the first row of the File Name column, replace the default file name with Large Credit Limits.

3. Enter the expression CREDIT_LIM >= 30000.

4. Click OK to start the extraction.

   The resultant database, Large Credit Limits, appears in the Database window. It contains 61 records.
5 Right-click the **Large Credit Limits** tab at the top of the Database window, and then select **Close**.

6 Close the **Customer-Database1** database.

---

### Importing a Text File

*Objective: To import the sales file that has been provided in Fixed Length text format.*

1 On the **Home** tab, in the **Import** group, click **Desktop**.

2 From the main Import Assistant dialog box, select **Text** from the list.

3 Click the **Browse** button adjacent to the **File name** box.

4 Select the **sales.txt** file. By default, the Select File dialog box opens to the Source Files Library group.

5 Click **Open**.

6 Click **Next**.

7 Once you have selected the data file, the Import Assistant analyzes the data file and tries to determine its type. IDEA correctly identifies the format as Fixed Length. Click **Next**.

8 During this step, IDEA correctly identifies the length of each record, which is 42 bytes (characters), including the record delimiters. IDEA automatically excludes the record delimiters from the import. Inspect the file in the preview section at the bottom of the dialog box. Scroll through the records and check that the columns of data (fields) line up. Click **Next**.
During this step, you can identify the start and end positions of each field within the records. The Import Assistant inserts lines for a best fit based on the pattern of data within the records. It is usual to obtain a record definition for Fixed Length files. Modify the line positions of the field delineators according to the following record definition. Click Next.

- INV_NO / Character / 17 / Invoice Number
- TRANS_DATE / Date / 88 / YYYYMMDD / Transaction Date
- PAY_TYPE / Character / 164 / Payment Method
- SALES_ID / Character / 203 / Salesperson ID
- CUST_NO / Character / 235 / Customer Number
- PROD_CODE / Character / 282 / Product Code
- AMOUNT / Numeric / 301 / 2 decimal places / Transaction Amount
10 During this step, you must enter the details for each field, including identifying which fields or areas you do not want to import. Use the information in the record definition that was provided in the previous step to complete the details for each field. Once you have defined all the fields, click **Next**.

![Import Assistant - Field Details](image)

11 During this step, you can add Virtual, Editable, Boolean, or Multistate fields to the file you are importing. For the purposes of this exercise, do not create any fields. Click **Next**.

12 At this stage in the import process you can enter an equation to filter the data that is to be imported into IDEA. For the purpose of this exercise, do not enter an equation. All records in the sales.txt file are required for subsequent exercises in this tutorial. Click **Next**.
13 During the final step, you must specify the import options and name the resulting database and then click **Finish**.

- Accept the option to import the file (rather than link to the file). IDEA runs faster when you import rather than link to a file.
- Select the **Generate field statistics** check box. The field statistics can be used for reconciliation.
- IDEA automatically saves the record definition as sales.rdf/.rdm in the Library. You can use this record definition later to import similar data files or modify the existing record definition.
- In the **Database name** box, enter **Sales Transactions**.

![Import Assistant - Specify IDEA File Name](image)

IDEA imports the file into the project, and then opens and displays it in the Database window.

14 In the **Properties** window, click **Control Total**.

15 Select the **AMOUNT** field, and then click **OK**.

The control total of 6,406,119.08 appears next to the Control Total link in the Properties window. Auditors should reconcile this amount to the total sales from an outside source for the period before commencing audit testing.
Summarizing the Data

Objective: To total the sales transactions by customer to produce a list of outstanding balances as well as to identify the number of active accounts and the number of transactions per account.

1. On the Analysis tab, in the Categorize group, click Summarization.

2. In the Summarization dialog box, select the CUST_NO field as the field to summarize and the AMOUNT field as the field to total.

3. Click Fields.

   The Fields dialog box appears. Note that no fields are selected. This stops unnecessary information from being included in the summarized database.

4. Click OK to return to the Summarization dialog box.

5. Select the Use Quick Summarization check box.

   The Use Quick Summarization check box may be selected as a faster means to summarize your database. However, Quick Summarization may only be used if the database has no more than 4,000 unique keys. In addition, Quick Summarization allows you to select only one field to summarize.

   Note that when Quick Summarization is used, Sum in the Statistics to include section is selected by default and the entire section greyed out.

6. Accept the option Create database as this database will be joined to the Customer-Database1 database in a later exercise.

   Note that as with most tasks in IDEA, you may apply a criterion to the task, for example, to only summarize transactions for a specified period. As with all other tasks where you can apply a criterion, if you apply the criterion to the database using the Criteria link in the Properties window, the criterion equation appears in the Criteria text box on the task dialog box.

   However, you may enter a new criterion or modify an existing one using the Equation Editor.
7. In the **File name** box, enter **Summarized Transactions**.

8. Click **OK**.

9. View the resultant database. Also note the number of records (303) on the Status bar.
Stratifying the Data

Objective: To stratify outstanding balances to gain a profile of the number and value of accounts within bands.

1. Ensure that Summarized Transactions is the active database and the Data property is selected in the Properties window.
2. In the Properties window, click Field Statistics.
3. Click Yes to generate the statistics.
4. View the numeric statistics for the AMOUNT_SUM field.
5. In the Properties window, click Data.
6. Right-click any record in the Database window, and then select Show Field Stats...
7. From the list of available statistics for Numeric fields, select the Net value, Absolute value, Minimum value, and Maximum value statistics.
8. Click OK.

The selected statistics appear in a yellow band at the top of the Database window.

9. Adjust the column widths, including the record number/statistic name column to view the full statistic names and totals. Move the cursor over the rows and note the tooltips displaying the statistic names.

10. Right-click any record in the database, and select Show Field Stats..., and then click Clear All.
11. Click OK to remove the Show Field Stats yellow band from the database.
12. On the Analysis tab, in the Categorize group, click Stratification.
13. In the Field to stratify box, select AMOUNT_SUM.
14. In the Fields to total on box, select NO_OF_RECS.
15. Change the increment to 5,000.00.
16. Click in the < Upper Limit text box of the first row.
17. Click the second row of the spreadsheet area.
18. Highlight the next three rows of the spreadsheet area to take the range to 25,000.00.
19. Change the increment to 25,000.00.
20. Highlight the next seven rows of the spreadsheet area (to row 12).
21. Ensure the Create result check box is selected.
22 In the **Result name** box, enter **Numeric Stratification**.

23 Click **OK**.

The Results output for the Summarized Transactions database becomes active and appears as a link in the Results area of the Properties window.
Note that there are 219 accounts in the first band (greater than or equal to 0 and less than 5,000.00).

24 On the File tab, in the Print group, click Print Preview.
25 Adjust the magnification to view the report (for example, 100%).
26 Return to viewing the Results output by closing the Print Preview window.

Viewing the Results Graph

Objective: To create a custom graph depicting the results of the Stratification task.

1 Ensure that Summarized Transactions is the active database and Numeric Stratification is selected in the Results area of the Properties window.
2 Graph the results by clicking the Alternates between displaying the results in a customizable graph and grid button on the Results toolbar.
3 Click the Gallery button on the Chart toolbar and select each chart type in turn to view the options available.
   As you select the different chart types, notice that the icon for the Gallery button on the chart toolbar changes to depict the type of chart selected.
4 Re-select the bar graph option.
5 Click the Properties button on the Chart toolbar.
6 Click the Y Axis tab.
7 Ensure the Show Gridlines check box is selected, and then click OK.
8 Place your cursor over stratum 6 in the graph and note that its color is solid and its X- and Y-axes values (stratum number and total amount) appear in a tooltip.
9 Click the stratum 6 bar, and then select Display Records to view the accounts making up the summary amount.

10 Click Done.
11 Return to viewing the stratification Results output grid by clicking the Alternates between displaying the results in a customizable graph and grid button on the Results toolbar.
12 In the Properties window, click Data to return to the Summarized Transactions database.
13 Close all open databases.

Creating a Pivot Table  
Objectives: To profile the Sales Transactions database in a table format and to create multiple summarizations in a table by calculating the sum, the average, or the count of items.

1 Open the Sales Transactions database.
2 On the Analysis tab, in the Categorize group, click Pivot Table.
3 In the Result name box, enter Sales Transactions Pivot Table, and then click OK.
In the Pivot Table Field List dialog box, click PAY_TYPE and drag it onto the row header field displaying Drop Row Fields Here. Click PROD_CODE and drag it onto the column header field displaying Drop Column Fields Here. Click AMOUNT and drag it onto the Drop Data Items Here area. Click Close.

If the data is too wide for the field, IDEA displays the values as pound signs (#). Simply click and drag the column separators to widen the fields in order to view the actual values.

You have just profiled the Sales Transactions database by payment type and product code with the sum of the amount for each combination of them.

Right-click one of the product code column headers to access a right-click menu. This menu provides options to hide the totals or to reverse the order of the product code display. Select and deselect the menu options and make note of the changes.

Right-click any record in the table to display the Pivot Table Field dialog box.

In the Summarize by list, click Count and then click OK.

View the records for the four sales of product code 02 that were paid using American Express (AMEX) by selecting the footer total for product code 02 and then clicking the View the records that make up a selected value in the Data area button on the Pivot Table toolbar.

Click Done.

The IDEA Pivot Table allows you to have multiple fields in the row, the column, or in the data area. Open the Pivot Table Field List dialog box by clicking the Opens the Pivot Table Field List dialog box button on the Pivot Table toolbar. Add the SALES_ID field to the column area, placing it to the left of the PROD_CODE field. Click Close.
11 Now, display only the sales of product codes 02 and 04, but have the sales ID as the primary focus. Click the drop-down arrow in the PROD_CODE field header and select only the check boxes for product codes 02 and 04.

12 Note that you can collapse or expand the detail of each salesman by clicking the plus or minus symbols next to the salesman number. To collapse all, right-click the SALES_ID field in the column area and then select Collapse all.

13 In the Properties window, click Data.

14 Close the Sales Transactions database.

Joining Databases  

Objective: To test if account credit limits have been exceeded.

1 Open the Summarized Transactions database. The common key by which the databases are to be joined is the customer number field in each database. The data type of this key field must be the same, but the field lengths may vary.

2 On the Analysis tab, in the Relate group, click Join. The Join Databases dialog box appears with Summarized Transactions listed as the primary database.

3 Click Fields for the primary database. The Fields dialog box appears. Note that all fields are selected for the resultant database.

4 Click OK to close the Fields dialog box.

5 Click Select to select the secondary database.

6 Select the Customer-Database1 database, and then click OK.

7 In the File name box, enter Customer Balances.

8 Specify the common match key by clicking Match.

9 Click the first row in the Primary column and select CUST_NO from the list of fields. Note the Order column and accept the default, Ascending.

10 Click the first row in the Secondary column, and then select CUST_NO from the list of fields.

11 Click OK.
12 Select the All records in both files option.

13 Click OK to join the selected databases.

14 View the resultant database, Customer Balances. It contains 351 records.

**Reviewing the History**

*Objective: To view the History maintained by IDEA to check what has been done.*

1 Ensure that Customer Balances is the active database and the Data property is selected in the Properties window.

2 In the Properties window, click History.

3 Expand out and examine each section of the History log.

4 Locate the last section, which contains the details of how the databases were joined.

Note the following:

- Number of records: 351 (matched sales to customers)
- Unmatched primary records: 10 (sales to customers not in the Customer-Database1 database)
- Unmatched secondary records: 48 (customers with no sales in the period)

5 Examine the IDEAScript code section of the Join Databases history. This can be used to re-perform or automate the audit tests.

6 Collapse the History for the Join Databases task.
Using Display All Records Containing

Objective: To find all unmatched records or all occurrences of a particular instance of data.

1. Ensure that Customer Balances is the active database and the Data property is selected in the Properties window.

2. Locate record 9. Note that there is no value in the CUST_NO1 field for this record (a sale for which there is no match in the Customer-Database1 database).

3. Right-click the blank record 9 for the CUST_NO1 field, and then select Display all records containing “”.
   The Display All Records Containing... dialog box appears.

4. Click OK.
   IDEA applies the criterion CUST_NO1 == “” to the database and displays it beside the Criteria link in the Properties window.
Note that there are 10 records that meet the specified criterion. This is the number of transactions for which there are no records in the Customer-Database1 database.

5 Right-click the Criteria link in the Properties window, and then select Clear. The criterion is removed from the database and all records are displayed.

6 Repeat the process to identify all customers with no sales in the period using the criterion CUST_NO ="". There are 48 records. These are the accounts with no outstanding balances.

7 Clear the criterion to return to viewing all records in the Customer Balances database.
Appending a Virtual Field

Objectives: To append a Virtual (calculated) field to calculate a new credit limit and to identify the accounts where the new credit limit has been exceeded.

1. Ensure that Customer Balances is the active database and the Data property is selected in the Properties window.

2. On the Data tab, in the Fields group, click Append.

3. Enter the following details:
   - Field name: NEW_LIMIT
   - Field type: Virtual Numeric
   - Length: Not applicable for Numeric fields
   - Number of decimals: 2
   - Parameter: CREDIT_LIM * 1.1
   - Description: Updated Credit Limit

4. Click OK to append the NEW_LIMIT field.
5 Scroll to the right of the display and note that the NEW_LIMIT field has been added as the last field in the database.

![Summarized Transactions](image)

The color of data in Virtual fields is determined by the color set in the Database Grid tab of the IDEA Options dialog box. The IDEA Options dialog box is accessible from the File tab.

### Performing a Record Extraction

**Objective:** To perform an extraction to identify accounts where the new credit limit has been exceeded.

1. Ensure that **Customer Balances** is the active database and the **Data** property is selected in the **Properties** window.
2. On the **Analysis** tab, in the **Extract** group, click **Direct**.
3. In the **File Name** column, replace the default file name with **Exceeded Credit Limits**.
4. Click the **Equation Editor** button, and then enter the equation \( \text{AMOUNT\_SUM} > \text{NEW\_LIMIT} \).
5 Click the **Validate and Exit** button on the Equation Editor toolbar to return to the Direct Extraction dialog box.

6 Click **OK**.

7 View the resultant database of 11 records (including sales to unauthorized customers).

8 Close all open databases.
Identifying Duplicate Invoices

Objectives: To test the validity of invoices and to test for duplicate invoice numbers.

1. Open the **Sales Transactions** database.
2. On the **Analysis** tab, click the **Duplicate Key** drop-down arrow, click **Detection**.
3. Leave the **Output Duplicate Records** option selected.
4. In the **File name** box, enter **Duplicate Invoices**.
5. Click **Key**.
6. In the **Field** column, select **INV_NO** and leave the direction as **Ascending**.
7. Click **OK** to return to the Duplicate Key Detection dialog box.
8. Click **OK** to run the task.
9. View the resultant database of 4 transactions with two pairs of duplicate invoice numbers (1000097 and 1000350), which should be investigated.

Identifying Gaps in an Invoice Number Sequence

Objectives: To test for completeness and to test for gaps in the invoice number sequence.

1. Open the **Sales Transactions** database.
2. On the **Analysis** tab, in the **Explore** group, click **Gap Detection**.
3. In the **Field to use** list box, select **INV_NO**.
4. In the **Character** area, accept the default mask (NNNNNNN).
5 In the **Output** area, ensure the **Create result** check box is selected.

6 In the **Result name** box, enter **Missing Invoice Numbers**.

7 Click **OK**.

The Results output Missing Invoice Numbers becomes active.

---

**Performing a Key Value Extraction**

*Objective:* To manually select records based on key values and extract them to a separate database.

1 Ensure that **Sales Transactions** is the active database and the **Data** property is selected in the **Properties** window.

2 On the **Analysis** tab, in the **Extract** group, click **Key Value**.

3 Click the **Browse** button adjacent to the **Existing keys** drop-down list.
4 Create the key PAY_TYPE/A + PROD_CODE/A and then click OK.

All of the different PAY_TYPE/A + PROD_CODE/A values are now listed and selected in the lower part of the dialog box.

5 Click Clear All, and then select only the VISA payments for product codes 05 and 06.

6 Optionally, you can enter criteria. Since the objective is to extract all of the sales transactions that were paid using VISA for product codes 05 and 06, leave the Criteria box empty.

7 Leave the Create a separate database for each unique key check box selected. Note that you could have decided to put all the resulting records in one database.

8 Click OK.
In the File Explorer window, IDEA has created two new child databases under the Sales Transactions parent database: KeyVal=VISA + 05 and KeyVal=VISA + 06.

9 Close all open databases.

10 Rename the two new child databases by right-clicking their names in the File Explorer window and then selecting Rename. Name the databases Visa Payments for Product Code 05 and Visa Payments for Product Code 06.

Performing a Record Extraction Using an @Function

Objective: To carry out a more advanced exception test in order to identify all transactions processed on a Sunday.

1 Open the Sales Transactions database.

2 On the Analysis tab, in the Extract group, click Direct.

3 In the File Name column, replace the default file name with Sunday Transactions.
4 Complete the equation so that it becomes $\text{Dow(TRANS\_DATE)} = 1$.

5 Click OK to perform the extraction. There are 152 Sunday transactions.

6 View the resultant database and its History.

7 Close the Sunday Transactions database.
Designing a Report  Objective: To select and format the data to be displayed and printed.

1. Ensure that Sales Transactions is the active database and the Data property is selected in the Properties window.

2. On the File tab, in the Print group, click Create Report to create a report using the view settings.

3. Select the Create new report option and the Allow headings to span multiple lines check box. Click Next.
4. In the field list, select each field (one at a time) and enter a short but descriptive name in the Text box. This text will be used for field names. Accept the default alignment selections. Click Next.

5. Define a report break on the CUST_NO/A + TRANS_DATE/D key. Click Next.

**Note:** IDEA displays the records in the report in the order of the index. IDEA displays the index description in the Indices area of the Properties window once you have completed the report.
6 Create a break and total the AMOUNT field for each customer number (CUST_NO). Select the following options: Count records in break, Show break line, Show leading break. Set the break spacing to 3 lines. Total the AMOUNT field. Select the Show shading and Use currency symbol options. Click Next.

7 Create grand totals for the AMOUNT field, set the font style to bold, and then click Next.
8 Enter/select the following information, and then click **Finish**.
   - Print cover page: Select this check box.
   - Title: Sales Transactions
   - Comments: Sequenced by customer number and date.
   - Prepared by: Enter your name or initials.
   - Header: Enter the name of your organization.
   - Footer: Enter the name of your department.
   - Date/Time: Accept the defaults unless you have particular preferences.

**Note**: The options you have selected affect how the report is printed. The name entered into the **Prepared by** field appears on reports accessed via the Print Preview of a Results output.

9 Once the report has been created using the Report Assistant, IDEA prompts you to preview the report that was created. Click **Yes**.

10 View the report, toggling between a single page and two pages.

11 Zoom in to view the report in detail. (There are two levels of zoom.)

12 Check that all settings, including field widths, are correct.
   **Note**: If you wish to print the view, click the **Print** button on the Print Preview window. All of the settings selected for the report (break totals, field headings, totals, and cover page information) are saved with the view. Every time you create a report, you must save the view in order to save the report settings.

13 Close the Print Preview window.
Creating an Action Field

Objective: To produce an action when you click on a value in a specified field.

1. Open the Customer-Database1 database.
2. Right-click any record in the CUST_NO field, and then select Define Action Field....
The Define Action Field dialog box appears.
3. Ensure that the Create Action Link to display extraction preview option is selected.
4. Click the Browse button and select the Summarized Transactions database. Click OK to close the Select Database window.
5. Click Look-up Fields.
6. On the Fields Not Found dialog box, click OK.
7. Ensure that the CUST_NO field is selected, and then click OK.
8. Click OK in the Define Action Field dialog box to create the Action Field link.

The Customer-Database1 database now has a link (in blue and underlined) to the Summarized Transactions database.
9 In the **CUST_NO** field, click the first record to display the Extraction Preview window. The transactions total for customer number 10000 is displayed.

10 Click **Done**.
Housekeeping

As with all computer systems, housekeeping (including backing up data and deleting unwanted files) is extremely important when working with IDEA.

**Backing Up and Restoring Data Files**

You may want to back up files for a variety of reasons, such as, to transfer files to another computer, to back up according to risk/criticality of data or because of disk space restrictions.

IDEA uses a single compound file with the file name extension *.imd (Unicode versions of IDEA use the file name extension *.idm) to store all the information associated with a file, such as the data, the schema, History, comments, indices, and reports.

IDEA stores each of these files in its project. However, the view files, equation files, definition files, and any text files created are not stored within the compound file.

The following list outlines the file type, the location and file name extensions (ASCII and Unicode). In order to backup IDEA Server project files, please contact your IDEA Server Administrator.

- Data and Related Files / Managed or External project / .IMD or .IDM
- Views / Library / .VW2 or .VWM
- Equations / Library / .EQX or .EQM
- Custom Functions / Library / .IDEAFUNC or .IDEAFUNC
- Record Definitions / Library / .RDF or .RDM
- Report Reader Templates / Library / .JPM or .JPM
- Project Information / Managed or External project / .INF
- IDEAScript Macros / Library / .ISS or .ISM
- Compiled IDEAScript / Library / .EXE
- Visual Script Macros / Library / .VSCRIPT
- External Variable Files / Managed or External project / .EVARS

Use File Manager, Windows Explorer, or any other backup facility to back up the required file.
Deleting Databases  

To delete the active database:
1. On the File tab, in the Database group, click Delete Database.
2. Confirm the deletion by clicking Yes.

To delete all or selected databases:
1. Ensure all databases are closed.
2. From the File Explorer toolbar, expand out all nodes in the File Explorer to display all files by clicking the File Display button and then selecting Expand All.
3. Select the databases you want to delete.
4. From the File Explorer toolbar, click the Delete button.
5. Confirm the deletion by clicking Yes.

Deleting Other Files  

Use the Library to delete other files, such as record definitions, views, and equations.

Copying Data Files  

To copy one or more selected databases to another project folder:
1. In the File Explorer window, right-click over the name of the database you want to copy.
2. Select Copy To...
3. Navigate to and select the required folder.
4. Click OK.

Moving Data Files  

To move one or more selected databases to another project folder:
1. In the File Explorer window, right-click over the name of the database you want to move.
2. Select Move To...
3. Navigate to and select the required folder.
4. Click OK.

Refreshing the File Explorer  

You can update the IDEA File Explorer one of two ways:
- Press F5.
- From the File Explorer toolbar, click the Refresh List button.
@Functions

IDEA provides @Functions for performing operations such as date arithmetic, financial and statistical calculations as well as text searches.

The @Functions are accessed through the Equation Editor. Quick help including the syntax, description, and an example of use for each of the @Functions is available when the @Function is highlighted. Additional and detailed help is provided in the Equation Editor Help system accessed through the Help button on the Equation Editor toolbar.

**Note:** You can also create custom functions. For more information, see the IDEA online Help.

Take a look at the definitions below to become familiar with each @Function:

- **@Abs:** Returns the absolute value of a numeric expression.
- **@Afternoon:** Returns 0 if time is in the AM and 1 if time falls in the PM and -1 for an invalid time.
- **@Age:** Calculates the number of days between two dates.
- **@AgeDateTime:** Returns the number of seconds between two dates and times.
- **@AgeTime:** Returns the number of seconds between two times.
- **@AllTrim:** Removes all leading and trailing spaces.
- **@Ascii** (not in Unicode versions of IDEA): Provides the ASCII value of a character.
- **@Between:** Determines if a numeric expression falls within a specific range.
- **@BetweenDate:** Returns a number indicating whether a date value falls within a specified range (1) or not (0).
- **@BetweenTime:** Returns a number indicating whether a time value falls within a specified range (1) or not (0).
- **@Bit:** Identifies a bit value.
- @BitAnd: Masks out unwanted bits.
- @BitOr: Sets required bit.
- @Chr (not in Unicode versions of IDEA): Provides the character equivalent of a specified ASCII code.
- @CompareNoCase: Ignores uppercase letters when comparing expressions.
- @CompIf: Determines if a record satisfies multiple criteria.
- @Ctod: Converts character dates to IDEA Date format.
- @Ctot: Converts a Character field containing time values stored as a string to a Time field with a Time format (HH:MM:SS).
- @CurForm: Converts numeric value into a formatted text.
- @CurVal: Converts formatted Character fields to Numeric fields.
- @Date: Returns the present date.
- @Day: Returns the day in a date expression.
- @DaysToD: Converts a number of days since Jan. 1, 1900 to date format.
- @Db: Calculates the fixed declining-balance depreciation for a specified period.
- @Ddb: Calculates double declining-balance depreciation.
- @Delete: Deletes a specified number of characters from a string.
- @Dow: Returns the day of the week.
- @Dtoc: Converts date expressions to character.
- @DtoDays: Reveals the number of days between Jan. 1, 1900 and a specified date.
- @Dtoj: Converts dates to Julian format.
- @Exp: Calculates the exponent of a numeric expression.
- @FieldStatistics: Returns the numeric value for a specified field statistic.
- @FindOneOf: Finds the position of the first matching character in 2 strings.
- @FinYear: Returns the financial year for a given date based on the year end.
- @Format12HourClock: Returns a string representing time formatted as HH:MM:SS TT.
- @Fv: Calculates the future value of an investment.
- @GetAt: Returns the character that appears in a specified numeric position.
- @GetNextValue: Returns the next value in the selected field.
- @GetPreviousValue: Returns the previous value in the selected field.
- @Hours: Returns the hours portion of a given time.
- @If: Allows a choice of two results based on the evaluation of a condition.
- @Insert: Inserts a string into an existing string.
- @Int: Returns the integer portion of a numeric value.
- @Ipmt: Calculates the interest payment for a given period.
- @Irr: Calculates internal rate of return.
- @IsBlank: Tests if a Character field is blank.
- @IsFieldDataValid: Returns a 1 if the data in the field is valid, or a 0 if the data is invalid.
- @Isin: Returns the starting position of a string within another string (case sensitive).
- @Isini: Returns the starting position of a string within another string (NOT case sensitive).
- @Jtod: Converts Julian dates to IDEA Date format.
- @JustLetters: Returns a string with all the numeric characters removed.
- @JustNumbers: Returns all the numbers (leading and trailing).
- @JustNumbersLeading: Returns the leading numbers.
- @JustNumbersTrailing: Returns the trailing numbers.
- @LastDayofMonth: Returns the last day for any given month and year combination.
- @Left: Returns the specified left-most characters in a string.
- @Len: Returns the length of a string, including any trailing spaces.
- @List: Determines which criteria in a list of values is met by an expression.
- @Log: Calculates natural logarithms.
- @Log10: Calculates logarithm 10x.
- @Lower: Converts all characters in a string to lowercase.
- @Ltrim: Removes leading spaces from a string.
- @Match: Determines which criteria in a list of values is met by an expression.
- @Max: Returns the greater value of two numeric expressions.
- @Mid: Extracts a portion of text from within a string.
- @Min: Returns the smallest value of two numeric expressions.
• @Minutes: Returns the minutes portion of a given time.
• @MIRR: Calculates modified internal rate of return.
• @Month: Returns the month in a date expression.
• @NoMatch: Determines if an expression meets none of the criteria in a list of values.
• @NPV: Calculates the net present value of an investment.
• @Ntod: Converts a numeric expression into an IDEA Date format.
• @Ntot: Converts a numeric field containing time stored as seconds to a Time field with a Time format (HH:MM:SS).
• @Pmt: Calculates a loan payment.
• @Ppmt: Returns the principal amount of a loan payment.
• @Precno: Returns the physical record number.
• @Proper: Capitalizes the first letter of each word in a string.
• @Pv: Returns the present value of an investment.
• @Qtr: Returns 1-4 representing the quarter a given date falls in based on the specified year end.
• @Random: Generates a random number.
• @Rate: Calculates the interest rate of an investment/loan.
• @Recno: Returns the logical record number (index sensitive).
• @RegExpr (not in Unicode versions of IDEA): Matches character expressions using a complex set of rules.
• @Remove: Eliminates all instances of a specified character.
• @Repeat: Repeats the first character of a string a specified number of times.
• @Replace: Replaces a string or substring with another.
• @Reverse: Reverses the order of characters in a string.
• @Right: Isolates the specified right-most characters in a string.
• @Round: Rounds to the nearest integer.
• @Seconds: Returns the seconds portion of a given time.
• @Seed: Sets the random number seed.
• @SimpleSplit: Extracts a segment of a character string that resides between the specified
xth occurrence of a specified start character (or character string) and the specified end character (or character string).

- @Sln: Returns the straight-line depreciation of an asset.
- @Soundex (not in Unicode versions of IDEA): Returns the sound code for a word.
- @SoundsLike (not in Unicode versions of IDEA): Determines whether two words are phonetically alike.
- @SpacesToOne: Strips spaces leaving only one space between words in a string.
- @SpanExcluding: Returns the characters in a string that appear before any characters in a specified string.
- @SpanIncluding: Returns the characters at the beginning of a string that match any character of a specified string.
- @Split: Breaks a character string into segments separated by characters, such as spaces or commas, and returns a specified segment.
- @Sqrt: Calculates a square root.
- @Str: Converts numeric expressions to strings.
- @Stratum: Groups records by interval.
- @Strip: Removes all spaces, punctuation and control characters.
- @StripAccent: Removes an accent from an accented character.
- @Syd: Returns the sum-of-years digit depreciation for an asset.
- @Time: Returns the present time.
- @Trim: Removes trailing spaces.
- @Ttoc: Converts a time or number into a string with the HH:MM:SS format.
- @Tton: Converts a Time field that has values stored in Time format (HH:MM:SS) to a Numeric field with the time value converted into seconds. This is the reverse of @Ntot.
- @Upper: Converts all characters in a string to uppercase.
- @Val: Converts a character expression to numeric.
- @Workday: Returns 1 if a given date falls between Monday-Friday and 0 if the date falls on a Saturday or Sunday.
- @Year: Returns the year in a date expression.
Index

Symbols
@Functions 53
 List of 53
 Numeric expression 53
 String 53

A
Action field 48
Appending a Virtual field 36
Arrow 17

B
Backing up data 51

C
Comments property 17
Control Total property 15
Copying databases 52
Criteria property 16

D
Data property 14
Databases
 Copying 52
 Deleting 49
 Moving 52
Deleting databases 49
Direct Extraction 26
Directional arrow 17
Display All Records Containing 36
Duplicate Key Detection 37

E
Extracting records 26
F
Field Statistics property 15
File Explorer window 18
    Refreshing 52
    Toolbar 18
File name extensions 51
Fly-out windows 18
    Running Tasks 18
    Search Results 19
Formatting the data 23
G
Gap Detection 38
Graphing the results 32
H
Help system 48
History property 14
I
IDEA Server project 12
IDEAScript window 18
    Toolbar 18
Importing
    Adobe PDF 43
    Microsoft Access file 22
    Print Report file 43
    Text file 27
Importing a Microsoft Access file 22
Importing a Text File 26
Indices property 17
Internet Explorer 48
J
Join Databases 34
K
Key Value Extraction 38
L
Library window 18
M
Managed Project 11
    Default 11
Moving databases 52
N
Numeric expression 53

P
Pivot Table 33
Projects
   IDEA Server 12
   Managed 11
   Selecting 21
Properties window 13
   Comments 17
   Control Total 15
   Criteria 16
   Data 14
   Field Statistics 15
   History 14
   Indices 14
   Results 16

R
Random Record Sampling 25
Refreshing the File Explorer 52
Reports 39
Results property 16
Ribbon 17
Running Tasks fly-out window 18

S
Search Results fly-out window 19
Searching records 47
   Wildcards 47
Selecting a project 21
Stratification 31
String 53
Summarization 29

T
Tasks that generate Results output 16
Time fields 46

V
Viewing the Field Statistics 24
Virtual (calculated) field 36

W
Website 11
Wildcards 47